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IMPORTANT WARNINGS 

 

 

  

   

BEFORE INSTALLING OR HANDLING THE DEVICE PLEASE CAREFULLY READ 

AND FOLLOW THE INSTRUCTIONS DESCRIBED IN THIS 

MANUAL. 

The device that this software is dedicated to has been developed to operate risk-free 

and for a specific purpose, as long as: 

the software is installed, programmed, run and maintained according to the instructions 

in this manual and by qualified personnel; 

all the conditions prescribed in the installation and user manual of the appliance in 

question are observed. 

All other uses and modifications made to the device that are not authorized by the 

manufacturer are considered improper. 

Liability for injury or damage caused by the incorrect use of the device lies exclusively 

with the user. 
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1. PRESENTATION 
 

ZMONITOR is the new software developed by 4-noks for managing parametric controllers. 

With a simple and intuitive user interface, ZMONITOR allows the complete configuration of the 

parameters available to the supervisor on a wide range of  4-NOKS devices, with the ability to 

install and configure third-party devices.  

The software can also be used to manage to record temporal parameters and save them in CSV 

format.  

 

MINIMUM SYSTEM REQUIREMENTS 
 

Hardware Requirements: 

- Processor: Pentium IV 1.0 GHz or higher. 

- RAM: 1 GB. 

- Hard disk: at least 100 MB free. 

- One free USB port for the USB GATEWAY 

- One 485 port available for GATEWAY 485 

-Network interface card or access to a network ETHERNET 

 

Software Requirements: 

 Operating system: Microsoft ® Windows ® XP Professional SP2, Windows ® Vista, 
Windows 8 

  

WARNING: you must log in as an administrator user on the computer to install the 
software correctly. 
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DEVICES TO BE MANAGED ZMONITOR 
ZMONITOR permette la gestione dei parametri dei dispositivi riportati nelle tabelli seguenti. 

 
GATEWAYS 
ZC_GW_USB 2053 
ZC_GW_ETH 2051 
ZC_GW_485 2051 
  
 
DEVICES 
ZR_TID Ver. FW Ver. Manuale 
ZR_PLUG 2053  
ZR_SWITCH 2053  
ZR_HMETER 2054  
ZR_BIDCI 2053  
ZR_TIDCI.D 2053  
ZR_TIREL2" 2051  
ZR_ES 2053  
ZR_AIC 2053  
ZR_AIV 2054  
ZED_THL 2053  
ZED_THI 2053  
ZED_TID 2053  
ZED_TIDCI 2053  
ZED_TCM 2054  
ZED_TCMR 2053  
ZED_TCMH 2053  
ZED_TCMHR 2051  
ZED_3IAC 2053  
ZED_3IACR 2053  
ZED_ICC 2053  
 
 
DEVICES THIRD PARTY 

CVM-MINI 
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2. INSTALLATION 
 

WARNING: you must uninstall previous versions.Select Uninstall from the menu START 

ZMONITOR. 

WARNING: Sometimes it is necessary to install the program 2 times. 

  

 

The site www.4-noks.com  find a link where you can download the latest version of the 

software. After downloading the zipped folder of ZMONITOR and it is opened, you have to click 

(as administrator) on the file "setup.exe" installation package to start the wizard process. 

CAUTION: Be sure to run the setup file with Administrator privileges. 

 

 

 

 

 

 

 

 

 

 

 

….the installer’s program will ask for confirmation to proceed ... (accept the license terms) 
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The next window allows you to choose which folder to install the software ZMONITOR, after 

choosing the address in which to install the program, press the NEXT button to continue 

..  

 

                             

…the software is automatically installed and is created on the desktop and program menus, 

shortcut icon for the file ZMONITOR.exe. 
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3. LANGUAGE 
To change the language go to IMPOSTAZIONI or Settings menu 

  

 

4. MAIN SCREEN  
This is the screen that presents the user ZMONITOR 

 

 

 

 

 

 

 

 

 

 

Legend 

1 Main Menu 
2 Function Keys 
3 Project Area 
4 Status Bar  (comunication status) 
5 Display area Logs 
6 Status Bar 
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5. MAIN MENU 
Provides access to the following function: 

 

FILE: 

 

 

TOOLS: 

 

 

SETTINGS: 

 

 

6. FUNTION KEYS 

 

Adds a device (gateway that is 

generic device) 
 

 

 

Reset the device (the device 

selected)  

 

Delete a device (any selected 

devices) 
 

 

 

Network Open / Close network 

(applies only to Gateway)  

 

Update the registers of all device   

 

Network Setup (applies only to 

Gateway)  

 

View level radio   

 

Disassociate  network  
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7. DESCRIPTION OF DEVICES 
The devices that we insert in the projects are of three types: 

GATEWAY 
 

Its task is to interface between the outside world and the network 

of family devices ZB-Connection (is also known as co-

ordinator).Exclusive product 4-noks. 

End DEVICE 
 

Generic device, including third parties. ZB-Connection devices 

permitted or generic devices that communicate over the Bridge 

485-485 4-noks (MODBUS protocol). 

Bridge 
 

Its task is to allow communication with peripherals modbus 

standard through the use of the radio network ZB-Connection. 

 

8. DISPLAY AREA PROJECT 
Each project is characterized by at least one GATEWAY and a sensor associated with him. It 

can add several GATEWAY also of the same type, each with a different logical ID. The display 

is a tree, where the nodes are composed of or GATEWAY BRIDGE. 

 

In addition to the description of the device, in parentheses shows the address. 

NOTE:    means that the device is not reachable. In this case the device as 

described BIDCI at 20. 

NOTE: GATEWAY may correspond to different addresses are the same. 

ATTENZIONE: for each gateway devices associated with it cannot have identical addresses. 
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9. DISPLAY AREA REGISTER 
 

 This area is divided into three columns: 

Register Address, Description, Value. The types 

of records is divided by color. It is not allowed to 

add or delete records, while the column Value / 

Value we set records. Some settings require 

multiple actions on multiple records 

simultaneously. Some registers are read-only: 

Input and Input Status register (those on white 

background).Coil Status (on green background) 

and Holding Register are editable. 

 

10. CONNECTION GATEWAY TO A PC 
To create a network, the first thing is always to connect and insert a GATEWAY. 

For each project can have multiple GATEWAY also of the same type, each with different 
logical address. For GATEWAY’s connections refer to the0 instructions. 

To insert a GATEWAY, in the project, select "New Project" and then 

click on  (Add new device). 

 

 

Select the type of GATEWAY (USB, Ethernet or 485), personalize it with a name and assign 

the logical address.  

 

Select the serial port and speed. This parameter 

is set by four DIP switches on the board (dip #4 

to OFF => 9600bps; dip # 4 to ON => 

19200bps). Confirm by pressing "Add".  
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Connection PC-USB Gateway 

In the case of USB Gateway set the logical address, communication port and speed. 

The logical address is set on the dip switches on the board (they are the first 3 dip and 
addresses range from 1 to 7). 

  

Confirm by clicking on the Add. 

 

 

 

 

Connection PC-Gateway 485 
In the case of 485 GATEWAY set the logical address, communication port and speed. 

The logical address is set on the dip switches 
on the board (they are the first 3 dip and 
addresses range from 1 to 7). 

Confirm by clicking on the Add. 

 

 

 

 

Connection PC-GATEWAY ETHERNET 
In the case of ETHERNET GATEWAY is important to know its address or rather its TCP HOST. 

 

 

The TCP PORT remains the "502". 

Confirm by clicking on the Add. 
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11. JOIN DEVICES 
Select the node to insert GATEWAY devices associated with this network. 

 

 

 

 

 

CAUTION: Each device associated with a Gateway must have unique address. 

 

Getting Started 

The gateway must have created a network. Read the instructions for the gateway or giving the 

Set Network command  .It is recommended that the Automatic selection. 

 

 

Confirm with OK. 

 

 

NOTE 1: Devices should be entered one at a time unless their address is not selectable via DIP 

or keyboard (such as TCM). The risk is to have devices with the same address (you will have 

conflicts about the data). 

JOIN 
NOTE 2: To join the devices push the button aboard the Gateway, or using the "Open / Close 

Network" command .  Remember to close the network using the same command. 

Make sure that the device is entered into the network: as a test, the gateway has a single 
flashing LED. 
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Select the just joined device, from the dropdown menu. Identify a meaningful name to the 

device. Write the logical address. Confirm by Add 

button 

.  

.  

Refer to the instructions to locate and then 

to assign an address 
 

Note: do not leave any device with address 16 or 127. This is because when 

you want to add another device you will have a data conflict. 
. 

At this point the display area will be populated registers its values. 

Important: it is useful to stimulate the device to a reception of the data, otherwise 

you have to wait the reception of the next packet 
 

 

 

 

 

 

 

Now you can add another device. 
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12. ADDING THIRD PARTY DEVICE through BRIDGE-485 

DEVICE 
In addition to the ZB-CONNECTION radio devices, you can insert third-party devices if 

connected through a 4-noks BRIDGE. In particular, devices with MODBUS protocol 485. The 

gateway node must enter a BRIDGE. The Bridge must be configured through their DIP switches 

on the board, and the only setting parameters are communication (Baud Rate, Parity, and Stop 

bits). 

 

There are no addresses to be set.  

 

After deciding to enter a BRIDGE, 
set him a name and a logical address. 
The latter is not important for the purposes of 
network, but only to be able to identify 
 

Click on add . 

 

At this point, we have created another node on the network. For example . 
 
Select to add a device and give the command add new. 
 
Ora lo selezioniamo per aggiungere un dispositivo e diamo il commando aggiungi nuovo 

dispositivo .. In questa nuova finestra scegliamo un dispositivo che eventualmente era 

stato creato precedentemente nella stessa sessione di esecuzione dell'applicativo, 

Oppure  scegliamo la voce 

CUSTOM_DEV, e gli diamo un nome e il 

suo indirizzo logico. 

La voce CUSTOM_DEV ci aiuterà per 

inserire un dispositivo uguale in un altro 

indirizzo. In pratica a questo dispositivo 

saranno associati i registri che saranno 

aggiunti. 

Ora procedere alla definizione dei suoi 

registri. 
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L’area dei registri risulta vuota. Utilizzare il comando Aggiungi registro e riempire l’area. 

 

Scegliere il tipo di registro, il suo indirizzo 

e  la sua descrizione. 

Dare l’OK.  

 

IMPORTANTE: i registri vanno immessi 

progressivamente partendo dal primo. 

L’inserimento dei registri è utile. Infatti uno stesso dispositivo potrà essere selezionato in un 

secondo tempo senza dover riconfigurare tutti i registri. 

 

IMPORTANTE: salvare il progetto. 

Nel momento in cui inseriamo un dispositivo uguale è sufficiente scegliere lo stesso ,assegnarli 

un altro nome con un indirizzo diverso e i registri saranno ripresi 

In questo documento il dispositivo  scelto è CUSTOM_DEV1. 

NOTA: la configurazione dei registri non viene esportata nei nuovi progetti. 

 

Come si vede a lato si è ripreso il CUSTOM_DEV1, è stato 

dato un altro nome e il suo indirizzo. 

Dopo aver dato il comando aggiungi, sono stati ripresi i 

registri impostati in precedenza (vedi immagine sotto). 
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13. AUTOMATIC DEVICE SCAN (only GATEWAY MODBUS 

RTU) 
 

From the Tools menu choose the command “Automatic devices scan” 

 

 

 

 

 

 

 

Select the serial port and begin with .  

 

Select the device, and click OK. It will create a node. 

The seek finds only GATEWAY Modbus RTU connect by 

the door that we have selected. 

 

From seek are excluded GATEWAY ETHERNET. 
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LOG FUNCTION 
It’s possible to generate a LOG file for the different registers. 

The output file is an .CSV. 

Select the output file to be created, the device and its registers. Also choose the period 
upgrade. Start the LOG. The generated file is a simple text file formatted 
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14. SAVE PROJECT 
To save your work, click “Save Project” from the File menu. The filename extension will .zmx 

 

 

15. OPEN PROJECT 
Jobs saved are obtained with “Open Project” from the File menu 

 

 

16. TUTORIAL 

Turn on Relay (on ZR-PLUG-M device) 
Example: To close the relay contact, go to the register described as "the electrical load is ON 
"and set to" YES ". If the relay was set to OFF then it will be activated. 
 

  

To open the relay contacts move to the register described as "Electrical load is set 
OFF "and set its value to" YES " 
 
You can know the status of the relay,  the register described as "output state 

(0=off,1=On)

 

 



 

20 
 

Impostazione soglie temperatura (esempio su TCM) 
To set the activation type of operation HOT, change the value of register described as 
Set_Caldo (° C or ° F). The entered value admits the decimal point. 
 

 

 

17. REFRESH Register 
With this setting is' can enable the automatic refresh the settings menu. In 
This data is updated. The validity of the data depends on the time of transmission each device. 
 

 

NOTE: in the case of networks with many devices 
can be delays in updating. 
 

 

 

 

18. DEBUG 
With this command, you can intercept the communication with its description of every single 

packet. 

. 
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19. COSA FARE IN CASO DI ……. 
 

 

Problema Causa probabile Cosa fare 

dispositivo non raggiungibile dispositivo non raggiungibile assicurarsi che il dispositivo 

sia acceso, oppure attendere 

la trasmissione successiva  
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For any suggestions or  problem please send an email to: 

 

info@4-noks.com 

  

  

  

4-noks reserves the right modify or change its products without prior warning 
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NOTE 
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4-NOKS s.r.l. 

Via per Sacile, 158  

-31018- Francenigo di Gaiarine (TV) 

Phone: (+39) 0434 768462 - Fax: (+39) 0438 694617 

www.4-noks.com - e-mail: info@4-noks.com 


